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R essentials: A short list (for now)
 Functions are (most often) verbs, followed by what they will
be applied to in parentheses:

do_this(to_this)

 Columns (variables) in data frames are accessed with $:

dataframe$var_name

 Packages are installed with install.packages, and
loaded with library , once per session:

install.packages("package_name")
library(package_name) 5/55



Today: Outline
 Why we care about Reproducibility
 R + markdown = Rmarkdown
 Controling output and input of rmarkdown
 Exercises on creating rmarkdown reports on the humble
platypus
 Form up assignment groups
 Quiz
 Assignment 1 released next week.
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We are in a tight spot
with reproducibility

Only 6 out of 53 landmark results could be reproduced
-- Amgen, 2014*

An estimated 75% - 90% of preclinical results cannot be
reproduced

-- Begley, 2015*
Estimated annual cost of irreproducibility for biomedical

industry = 28 Billion USD
-- Freedman, 2015*

* Heard via Garret G7/55

https://www.nature.com/articles/483531a
https://www.ncbi.nlm.nih.gov/pubmed/25552691
https://journals.plos.org/plosbiology/article?id=10.1371/journal.pbio.1002165
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So what can we do about
it?
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Reproducibility checklist
Near-term goals:
 Are the tables and �gures reproducible from the code and
data?
 Does the code actually do what you think it does?
 In addition to what was done, is it clear why it was done?
(e.g., how were parameter settings chosen?)

Long-term goals:
 Can the code be used for other data?
 Can you extend the code to do other things?
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Literate programming is a partial solution


Literate programming shines some light on this dark area of
science.


An idea from Donald Knuth where you combine your text with
your code output to create a document.


A blend of your literature (text), and your programming (code),
to create something you can read from top to bottom.
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https://en.wikipedia.org/wiki/Donald_Knuth


So
Imagine a report:
Introduction, methods, results, discussion, and conclusion,
and all the bits of code that make each section.
With rmarkdown, you can see all the pieces of your data analysis
all together.
Each time you knit the analysis is ran from the beginning
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Markdown as a new player to legibility
In 2004, John Gruber, of daring �reball created markdown, a
simple way to create text that rendered into a HTML webpage.
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https://en.wikipedia.org/wiki/John_Gruber
https://daringfireball.net/
https://en.wikipedia.org/wiki/Markdown


- bullet list
- bullet list
- bullet list

 bullet list
 bullet list
 bullet list

Markdown as a new player to legibility
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1. numbered list
2. numbered list
3. numbered list
bold, bold,
italic, italic

quote of
something
profound

Markdown as a new player to legibility
1. numbered list
2. numbered list
3. numbered list

__bold__, **bold**, 

_italic_, *italic*

> quote of something pr
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Markdown as a new player to legibility
With very little marking up, we can create rich text, that actually
resembles the text that we want to see.
Learn to use markdown Spend �ve minutes working through
markdowntutorial.com
This the end of part 1 of lecture 1b
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https://www.markdowntutorial.com/


Start of part 2 of lecture
1b
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Rmarkdown helps address the reproducibility problem


Q: How do we take markdown + R code = "literate
programming environment"


A: Rmarkdown
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Rmarkdown...
Provides an environment where you can write your complete
analysis, and marries your text, and code together into a rich
document.
You write your code as code chunks, put your text around that,
and then hey presto, you have a document you can reproduce.
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Reminder: You've already used rmarkdown!
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How will we use R Markdown?
 Every assignment + project / is an R Markdown document
 You'll always have a template R Markdown document to start
with
 The amount of scaffolding in the template will decrease over
the semester
 These lecture notes are created using R Markdown (!)
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The anatomy of an rmarkdown document
There are three parts to an rmarkdown document.
 Metadata (YAML)
 Text (markdown formatting)
 Code (code formatting)

DEMO
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Metadata: YAML (YAML Ain't Markup Language)


The metadata of the document tells you how it is formed -
what the title is, what date to put, and other control
information.


If you're familiar with , this is similar to how you specify
document type, styles, fonts, options, etc in the front matter /
preamble.

LT XA
E
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Metadata: YAML
 Rmarkdown documents use YAML to provide the metadata. It
looks like this:

---
title: "An example document"
author: "Nicholas Tierney"
output: html_document
---

It starts an ends with three dashes ---, and has �elds like the
following: title, author, and output.
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1. bullet list
2. bullet list
3. bullet list

1. bullet list
2. bullet list
3. bullet list

Text
Is markdown, as we discussed in the earlier section,
It provides a simple way to mark up text
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Code
We refer to code in an rmarkdown document in two ways:

1. Code chunks, and
2. Inline code.
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Code: Code chunks
Code chunks are marked by three backticks and curly braces
with r inside them:

```{r chunk-name}
# a code chunk
```
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Code: backtick?
A backtick is a special character you might not have seen
before, it is typically located under the tilde key (~). On USA /
Australia keyboards, is under the escape key:

image from
https://commons.wikimedia.org/wiki/File:ANSI_Keyboard_Layout_Diagram_
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https://commons.wikimedia.org/wiki/File:ANSI_Keyboard_Layout_Diagram_with_Form_Factor.svg


Code: Inline code
Sometimes you want to run the code inside a sentence. This is
called running the code "inline".
You might want to run the code inline to name the number of
variables or rows in a dataset in a sentence like:

There are XXX observations in the airquality
dataset, and XXX variables.
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Code: Inline code
You can call code "inline" like so:

Which gives you the following sentence

There are 153 observations in the airquality
dataset, and 6 variables.

There are `r nrow(airquality) ` observations in t
and `r ncol(airquality) ` variables.
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Code: Inline code


If your data changes upstream


You don't need to work out where you mentioned your data


You just update the document. 🎉
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Your Turn: Put it together
Download "mida-exercise-1b.zip" from the course website
 open the document "01-oz-atlas.Rmd"
 knit the document
 Change the data section at the top to be from a different
state instead of "New South Wales"
 knit the document again
 How do the text and �gures in the document change?
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End of part 2 of Lecture
1B

Make sure you �nish the exercise on the rstudio.cloud
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Start of part 3 of Lecture
1B
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Code: Chunk names
Straight after the ```{r you can use a text string to name the
chunk:

```{r read-crime-data}
crime <- read_csv("data/crime-data.csv")
```
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Code: Chunk names
Naming code chunks has three advantages:

1. Navigate to speci�c chunks using the drop-down code navigator
in the bottom-left of the script editor.

2. Graphics produced by chunks now have useful names.
3. You can set up networks of cached chunks to avoid re-

performing expensive computations on every run.
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Code: Chunk names
Every chunk should ideally have a name.
Naming things is hard, but follow these rules and you'll be �ne:

1. One word that describes the action (e.g., "read")
2. One word that describes the thing inside the code (e.g,

"gapminder")

3. Separate words with "-" (e.g., read-gapminder)
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Code: Chunk options
You can control how the code is output by changing the code
chunk options which follow the title.

```{r read-gapminder, eval = FALSE, echo = TRUE}
gap <- read_csv("gapminder.csv")
```

What do you think this does?
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Code: Chunk options
The code chunk options you need to know about right now are:

 cache: TRUE / FALSE. Do you want to save the output of the
chunk so it doesn't have to run next time?

 eval: TRUE / FALSE Do you want to evaluate the code?

 echo: TRUE / FALSE Do you want to print the code?

 include: TRUE / FALSE Do you want to include code output
in the �nal output document? Setting to FALSE means nothing
is put into the output document, but the code is still run.

You can read more about the options at the o�cial
documentation: https://yihui.name/knitr/options/#code-
evaluation
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https://yihui.name/knitr/options/#code-evaluation


Your turn
 Go back to the document 01-oz-atlas.Rmd and change
the document so that the code output is hidden, but the graphics
are shown. (Hint: Google "rstudio rmarkdown cheatsheet" for
some tips!)
 Re-Knit the document.
 Take a look at the R Markdown Gallery.
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https://rmarkdown.rstudio.com/gallery.html


End of Part 3 of Lecture
1B
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Start of Part 4 of Lecture
1B
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Global options: Set and forget
You can set the default chunk behaviour once at the top of the
.Rmd �le using a chunk like:

knitr::opts_chunk$set(
  echo = FALSE,
  cache = TRUE
)

then you will only need to add chunk options when you have the
occasional one that you'd like to behave differently.
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Your turn
 Go to your 01-oz-atlas.Rmd document on
rstudio.cloud and change the global settings at the top of
the rmarkdown document to echo = FALSE, and cache =
TRUE

knitr::opts_chunk$set(
  echo = FALSE,
  cache = TRUE
)

 Update the other code chunks by removing the code chunk
options.
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End of part 4 of lecture
1b
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Start of part 5 of lecture
1b

49/55



DEMO
The many different outputs of rmarkdown
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Your turn: Different types of documents
1. Change the output of your current R Markdown �le to produce a

Word document. Now try to produce pdf - this may not work!
That's OK, we do'nt need it right now.

2. Create a new document that will produce a slide show File >
New R Markdown > Presentation

3. Create a �exdashboard document - see this option in the File
> New R Markdown > From template list.
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Your Turn
 Open the oz-atlas-final.Rmd from the mida-exercise-1b
project
 Read through the document and add text where prompted to
learn more about the Australian native platypus!
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Recap:
 There is a Reproducibility Crisis
 rmarkdown = YAML + text + code
 rmarkdown has many different output types
 Platypus are interesting!
 Assignment will be announced later today
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Learning more:
 R Markdown cheat sheet and Markdown Quick Reference
(Help -> Markdown Quick Reference) handy, we'll refer to it often
as the course progresses
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https://github.com/rstudio/cheatsheets/raw/master/rmarkdown-2.0.pdf


That's it!
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